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.Institute Hotel Management Catering Nutrition

IHM, Lucknow is an institute of high repute and excellence under the aegis of Ministry of Tourism,
Govt. of India & Uttar Pradesh. The institute imparts quality training and education in the field of
Hospitality and Tourism Industry.

Established in year 1969 as a Food Craft Institute and upgraded to an Institute of Hotel Management
in year 1980 to conduct the 3 years Diploma course, as Sth oldest govt. run IHM of the country. We ranked
6" all across the country according to the Magazine "India Today" & "ASSOCHAM INDIA" in 2016.

This institute offers students the opportunity to develop professional and academic excellence with
a view to enjoy a rewarding career as a Hotel or Restaurant Manager, Food & Beverage Manager, Front
Office Manager, Exccutive Chef or as an Exccutive House-Keeper etc. Whatever be the career choice
students expect that the Hospitality training they receive at IHM, Lucknow will allow them to begin work in
their profession as soon as they pass out.

Institute of Hotel Management is affiliated with NATIONAL COUNCIL FOR HOTEL
MANAGEMENT AND CATERING TECHNOLOGY, NOIDA, U.P., INDIA; which is an apex body
under the MINISTRY OF TOURISM, GOVERMENT OF INDIA.

The National Council for Hotel Management was set up in 1982 with a Board of Governors,
comprising Government and trade representatives, to look after its affairs. The Council has been assigned
the role of assigning and advertising the Government in the coordinated development of training programs
in Hotel Management and related fields. Its main concern is directed towards growth and development of
the institutes of Hotel Management & Catering technology all over the country and to affiliate existing
institutes of similar nature.

The National council conducts courses at Post Graduation, Graduation, Diploma, Post-Diploma &
Certificate levels to develop tomorrow's top professionals in the Hospitality related enterprises. The
National Council also prescribes common syllabi for all its courses; conducts research studies in the field of
Hotel and Restaurant Management and awards Post Graduation, Graduation, Diploma, Post-Diploma &
Certificates to successful candidates.

IHM,Lucknow is spread in 5 acres land at the prime location of the city. Institute has 1,10000 sq.fts
of training space making it one of the largest Institutes of Hotel Management across the country.

ALUMNI - Alumni of the institute are spread across the world and are well communicated with
each other through regular interaction.
AIM - To take the steps towards fulfilling the human resource requirement of Hospitality

industry and do all possible efforts to raise the standard of services being offered to the
guest in hospitality industry up to their delight.
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- quality of Hospitality
professional
excellence with a view to enjoy a rewarding career in Hotels, Restaurants and allied
profession. We assist the students in developing their personality with due emphasis to
discipline, dedication, attitude and commitment along with imparting knowledge and

FACULTY - faculty exposure
commited to impart knowledge and skill keeping pace with latest trend of hospitality
Industry.

%2 Year Diploma in Food Production/Bakery & Confectionery/Food &
Beverage Service.

Overview of the Syllabus :
1.FOOD PRODUCTION-

Food Production and requirement, culinary history and recipes, hot and cold food, confectionery
and bakery, equipment and tools, menu planning and mise en place, cost control, larder work establishing

and evaluation standard recipe cards, Indian, Chinese and advanced Continental Cookery.

2. BAKERYAND CONFECTIONERY -
Art & Science of Making Yeast Product, Cake, Pastry, Puffe, Chocolate, Cheese etc.

3.FOOD & BEVERAGE SERVICE -

Preparation and techniques of services, restaurant and special event service, consumer interests and
styles, restaurant equipment, types of beverages and bars, planning and merchandising, conventions, table

plans, protocol Gueridon services, restaurant layout and etiquette, formal and informal gathering, seating
arrangements.
. Opportunities for Diploma
Kitchen /Food & Beverage Service Trainees in Hotels

Hospital and Institutional Catering Trainees

Trainees in Tourism Development Corporations and Resort properties
Kitchen/ Food and Beverage Service trainee positions in Hotels

Indian Navy/Indian Army/Armed forces Canteen Hospitality services;
Guest/Customer Relation Executive in Hotel and other Service Sectors;
Resort Management




LUCKNOW,

» Self- employed through entrepreneurship.
» Multinational companies for their hospitality services.
» Retail, Entertainment, Life style, and social catering.

4. Eligibility for admission

4.1 Qualifying Examination
A pass in 10+2 system of Senior Secondary examination or its equivalent. Those
appearing in 10+2 or equivalent examination can also appear in Diploma courses. Provisional
admission will stand cancelled if proof of having passed the qualifying examination (10+2 or
its equivalent) is not submitted at the time of admission. The offer of admission is subject to
verification of original certificates / documents at the time of admission.

4.2 Age: No Age Bar

5. Reservations of seats

Reservation for SC/ST/OBC/EWS Categories as per the rules of the Government of India.

6. Availability of seats

Diploma in Food Production -58 Seats
Diploma in Bakery and Confectionery -35 Seats
Diploma in Food & Beverage Service -58 Seats

7. Guidelines for filling up the application forms

The candidates are advised to go through the Admission Brochure carefully and acquaint
themselves with all requirements in respect to filling up of the Application form. It will be the
sole responsibility of the candidate to make sure that he/she is eligible and fulfills all the
conditions prescribed for admission.
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Documents required

When a candidate is granted admission he/she must produce the following documents in Original
for verification, failing which he/she will not be granted admission.

1. Aschool orcollege leaving certificate.

2. Mark sheet of class 10thand 12th.,

Character Certificate issued by last attended school/college.
Reserve Category Certificate.

IHM Lucknow fee receipt issued.

Income certificate issued by the Competent Authority.

Payment of fees 1% Term 27 Term
1. Diploma In Food Production 324,200/ Z18,500/-
2. Diploma In Bakery & Confectionery 324,200/- X18,500/-
3. Diploma in Food and Beverage Service %19,700/- %14,500/-

Students selected for admission in various programs of Diploma Courses are required to pay
above prescribed fee in two installments each at eh time of Admission and in December respectively
against their course offered after getting their roll number from the institute.

Fee includes Refundable Caution Money for Diploma in Food Production: ¥3000/-

Diploma in Bakery and Confectionery: 33000/-
Diploma in Food & Beverage Service: 32500/-
Fee once paid will not be refunded expect the refundable caution money.
The mode of payment of fee would be both online and Offline.
For Online Mode: The Payment can be made through Debit Card/Credit card & net Banking by
Using institute website www.ihmlucknow.com
For Offline Mode: Students are required to get the print out of the Challan from the Institute
website www.ihmlucknow.com
8.4  Merit,scholarship and financial assistance

As per the Uttar Pradesh Government policy Scheduled Caste/Scheduled Tribe and other categories
candidates can avail financial assistance from the respective State Government Welfare Department for
which Institute will issue bonafide certificate indicating fee received from the student.

Induction for the batch will commence from July.

(08)




Eligibility:
English as a subject.
Duration:
Teaching hours per week: 35 Hours
Effective teaching: 34 weeks

Industrial training:

DIPLOMA IN FOOD PRODUCTION

Senior Secondary (10+2) or equivalent with

One Year + six months in industry

TEACHING AND EXAMINATION SCHEME

24 weeks after the annual examinations.

No. | Subject Subject Hours per Term
code week Marks*
THEORY
1 DFP-01 | Cookery 3 100
2 DFP-02 | Larder 2 50
3 DCS-01 | Hygiene & Sanitation 2 50
4 DFP-03 | Nutrition 1 50
5 DFP-04 | Commodities 2 50
6 DCS-02 | Food Costing 2 50
TOTAL 12 350
PRACTICAL
7 DFP-11 | Cookery 16 100
8 DFP-12 | Larder 4 100
9 DCS-11 | Computer Awareness 1 -
10 DCS-12 | Library 2 -
TOTAL 23 200
GRAND TOTAL 35 550

* Term marks will comprise 30% Mid Term Exam & 70% End Term Exam Marks.

RULES AT A GLANCE

NO. TOPIC REQUIREMENT
1 Minimum attendance required to become eligible for 75% in aggregate
exam
2. | Minimum pass marks for each theory subject 40%
3. | Minimum pass marks for each practical subject 50%
4. | Maximum duration to pass/clear all subjects/ papers | 03 academic years

o
J L National Council for Hotel Management & Catering Technology, Noida.




COOKERY THEORY (DFP-01)

TIME ALLOTTED: 03 HOURS PER WEEK

MAXIMUM MARKS: 100

ACTIVITY MAXIMUM MARKS
Marks for attendance 5
Mid-term exam marks 25
Total (Incourse Assessment Marks) 30
End term exam marks 70
Total 100

Knowledge based objectives for Cookery Theory:-

After the completion of Cookery Theory subject, the Students will be able to:

=

Design the layout of Kitchen.

Classify raw materials and their uses.
Describe the methods of mixing food.
Draw the structure of egg.

Explain the balancing of recipes.
Define and classify sauces and soups.
Breads and bread making

Different types of pastries

© XN OA~®DN

Explain the Organizational Structure of Food Production Department.

10 Kitchen equipment and its upkeep and interdepartmental coordination

UNIT CONTENT

HOURS WEIGHTAGE
ALLOTTED FOR EXAM

1 Origin of hotel industry

Importance of kitchen in Hotel &
Catering establishments

Aims and objectives of Cooking
Classification of raw materials,
preparation of ingredients.

Methods of mixing foods, effect of
heat on various foods, weighing and
measure, texture of food, Culinary terms.

08 10%

2 Methods of cooking with special
Application to meat, fish, vegetables,
cheese, pulses and egg. Conventional
and non-conventional methods of
cooking, solar cooking, microwave
cooking, fast food operation.

07 10%

o
J L National Council for Hotel Management & Catering Technology, Noida.
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Eggs — Structure, selection of quality,
various ways of cooking eggs with
example in each method and prevention
of blue ring formation. Varieties of fish,
meat and vegetables. Accompaniments,
garnishes and rechauffe.

10

10%

Balancing of recipes, standardization of
recipes, standard yield, maintaining
recipe files. Menu planning, portion
control, brief study of how portions are
worked out. Invalid cookery. Purchase
Specifications, quality control, Indenting
and Costing

10

10%

Description and use of the following:
Basic stocks, Aspics & Jellies. Roux
blanc, Roux blonde and Roux brun,
Recipes and quantities required to
produce 10 litres of stock, white &
brown. Recipes required to produce
one litre of the following:

Béchamel sauce, tomato sauce,
Veloute sauce, espagnole sauce,
Hollandaise and mayonnaise sauce
with the necessary precautions to be
observed while preparing these, with
minimum five derivatives of each.

Soup — Definition, classification of
soups with example in each group,
recipefor one litre
consommé, 10 popular
consommeés with their garnishes.

10

10%

MID TERM EXAM

Vegetables — Effect of heat on different
vegetables in acid/alkaline medium
and reaction with metals. Method of
cooking different vegetables with
emphasis on cooking asparagus,
artichokes, brussel sprouts.

12

15%

Theory of Bread making, Bread rolls,
Bread sticks, Indian Breads.

5%

Pastry — Recipes of short crust
pastry, puff pastry, flaky pastry choux
paste, Danish pastry and their
derivatives. Recipes and method of

15

20%

National Council for Hotel Management & Catering Technology, Noida.
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preparation of plain ice cream.

9 Kltchen stewarding and upkeep of 05 05%
equipment.

10 | Staff organization of Kitchen, 0
coordination with the Departments. 05 05%
Total 90 100%

o
J L National Council for Hotel Management & Catering Technology, Noida.
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LARDER THEORY (DFP-02)

TIME ALLOTTED: 02 HOURS PER WEEK

MAXIMUM MARKS: 50

ACTIVITY MAXIMUM MARKS
Marks for attendance 2%
Mid-term exam marks 12 %
Total (Incourse Assessment Marks) 15
End term exam marks 35
Total 50

Knowledge based objectives for Larder Theory:- After the completion of the

Larder Theory, the Students will be able to:

1.

Design the layout of Larder Department.

2. Explain the Organizational Structure.
3. ldentify and draw the tools and equipment used in Larder Department.
4. Classify and define cuts and uses of Fish, Poultry, Lamb, Beef and Pork
5. Explain the procedures of maintaining Larder Equipment.
UNIT CONTENT HOURS WEIGHTAGE
ALLOTTED FOR EXAM
1 Larder organization and layout. 06 10%
Larder control- maintenance and care of
larder equipment
2 Hors d’ oeuvre and salads- classification 06 10%
3 Fish — classification, cleaning, basic cuts 06 10%
and uses and storage
4 Poultry and game- classification 12 20%
preparation and cuts with uses
MID TERM EXAM
5 Butchery — cuts of beef, lamb, mutton 12 20%
and pork-uses and weights
6 Types of force meat and uses 06 10%
7 Assembling cold buffet, sandwiches and 06 10%
canapés, decorative work with ice,
vegetable, butter/fat and fruit
8 Cleaning and care of larder equipment 06 10%
and tools
Total 60 100%

o
J L National Council for Hotel Management & Catering Technology, Noida.
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HYGIENE AND SANITATION (DCS-01)

TIME ALLOTTED: 02 HOURS PER WEEK

MAXIMUM MARKS: 50

ACTIVITY MAXIMUM MARKS
Marks for attendance 2%
Mid-term exam marks 12 Y2
Total (Incourse Assessment Marks) 15
End term exam marks 35
Total 50

LEARNING OBJECTIVES: After completion of the subject a student will be able to:

1. Understand Food Microbiology, Food Contamination and Spoilage;

Follow sanitary procedure during food handling;
Understand the importance of personal hygiene
Analyse critical control points; and

a e

Practice laws governing the food safety and standards

No CONTENT

TIME WEIGHTAGE
ALLOTTED | FOR EXAM

1 | FOOD MICROBIOLOGY
¢ Introduction
e Microorganism groups important in food
microbiology
- Viruses
- Bacteria
- Fungi (Yeast & Molds)
- Algae
- Parasites
e Factors affecting the growth of microbes
e Beneficial role of Microorganisms

10 15%

2 | FOOD CONTAMINATION AND SPOILAGE

¢ Classification Of Food

e Contamination And Cross
Contamination

e Spoilages Of Various Food With The
Storing Method

05 10%

3 | SANITARY PROCEDURE FOLLOWED DURINC
FOOD HANDLING
e Receiving,
e Storage,
e Preparation,
e Cooking,

¢ Holding, and

10 20%

o
J L National Council for Hotel Management & Catering Technology, Noida.
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e Service Of The Food

MID TERM EXAM

SAFE FOOD HANDLER
e Personal Hygiene discussing all the
standard.
e Hand Washing Procedure
e First Aid definition, types of cuts,
wounds, lacerations with reasons and
precautions.

10

15%

HAZARD ANALYSIS CRITICAL CONTROL
POINT

e Introduction to HACCP

e History

e Principles of HACCP

10

15%

FOOD SAFETY STANDARDS AUTHORITY
OF INDIA (FSSAI)

¢ Introduction to FSSAI

¢ Role of FSSAI

e FSSAI compliance

05

15%

GARBAGE DISPOSAL
e Different Methods
e Advantages and disadvantages
e Municipal Laws and Swachh Abhiyan

10

10%

Total

60

100%

o
J L National Council for Hotel Management & Catering Technology, Noida.
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NUTRITION (DFP-03)

TIME ALLOTTED: 01 HOURS PER WEEK

MAXIMUM MARKS: 50

ACTIVITY MAXIMUM MARKS
Marks for attendance 2%
Mid-term exam marks 12 %
Total (Incourse Assessment Marks) 15
End term exam marks 35
Total 50

Learning objectives: After completion of the Nutrition subject a student will be able

to:
1. Develop basic awareness of important nutrients;
2. Knowledge of nutritional requirements for human beings;
3. Plan nutritionally balance menu; and
4. Planning of menus for special needs.
UNIT CONTENT HOURS WEIGHTAGE

ALLOTTED | FOR EXAM

1. | BASIC ASPECTS
e Definition of Food and Nutrition
e Importance of Food
- Physiological, o
- Psychological and 03 10%
- Social
e Functions of food (in maintaining good
health)
2. | CLASSIFICATION OF NUTRIENTS
e Macro Nutrients
- Carbohydrates
o Simple
= Monosaccharides
= Disaccharides
o Complex
= Polysaccharides
- Fats
o Saturated 04 10%

o Unsaturated
= Monounsaturated
= Polyunsaturated

- Proteins
o Based on structure
= Fibrous
=  Globular

» Intermediate
o Based on composition

o
J L National Council for Hotel Management & Catering Technology, Noida.
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=  Simple
= Conjugated
- Water
Micro Nutrients
- Vitamins
o Water soluble
o Fat soluble
- Minerals
o Macro elements
o Trace or Micro
elements

MACRO NUTRIENTS

Carbohydrates

- Functions of Carbohydrates

- Sources

- Recommended Daily Allowances
(RDA)

- Effects of Deficiency and excess
intake of Carbohydrates

Fats

- Functions of Fats

- Sources

- Recommended Daily Allowances
(RDA)

- Effects of Deficiency and excess
intake of Fats

Proteins

- Functions of Proteins

- Sources

- Recommended Daily Allowances
(RDA)

- Effects of Deficiency and excess
intake of Proteins

Water

- Functions

- Source

- Recommended Daily Allowance
(RDA)

04

15%

MICRO NUTRIENT

Vitamins

Functions, sources, Recommended
Daily Allowances (RDA) and Effects of
Deficiency / Excess intake of;

- Vitamins of B-Complex Group

- Vitamin C

- Vitamin A

- Vitamin D

- Vitamin E

- Vitamin K

Minerals

04

15%

o
J L National Council for Hotel Management & Catering Technology, Noida.
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Functions, Sources, Recommended
Daily Allowances (RDA) and Effects of
Deficiency / excess intake of;

- Calcium

- lron

- lodine

- Sodium

- Phosphorous

MID TERM EXAM

CONSERVING NUTRIENTS

e During Storing

e During Food Preparation (Pre-cooking
e.g. Washing, Peeling, Cutting,
Chopping, Slicing, Pounding, Grinding,
Soaking, Sprouting, Fermentation,
Mixing)

e During Cooking

04

10%

BALANCED DIET
e Definition and its importance
e Factors Affecting Balanced Diet (Age,
Gender and Physiological state)

03

10%

MENU PLANNING
e Nutritionally balanced meals as per
three food group system
e Factors affecting meal planning
e Calculation of Nutritive value of dishes
and meals
e Critical evaluation of a given meal

04

15%

MENU PLANNING — FOR SPECIAL NEEDS
e Obesity
e Diabetes
e Hypertension
e Cardiac

04

15%

30

100%

o
J L National Council for Hotel Management & Catering Technology, Noida.
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COMMODITIES THEORY (DFP-04)

TIME ALLOTTED: 02 HOURS PER WEEK

MAXIMUM MARKS: 50

ACTIVITY

MAXIMUM MARKS

Marks for attendance 2%
Mid-term exam marks 12 %
Total (Incourse Assessment Marks) 15
End term exam marks 35
Total 50

Learning Objectives for Commodities:- After the completion of the Commaodities
subject, the students will be able to:

1.

»wn

© NGO

Classify Cereals and Describe their uses and storage.
Classify Pulses and Describe their uses and storage.

Define and Classify Fruits and Vegetables.

Classify dairy products and describe the composition and storage of milk,

cheese, butter and cream.
Find and Test the food adulterants.

Fruits and vegetables classification and uses

Identification and uses of spices and herbs

Define and classify tea, coffee, coco and food colours and flavours.

Preservation of food

UNIT

CONTENT

HOURS
ALLOTTED

WEIGHTAGE
FOR EXAM

Cereals- wheat rice maize

Breakfast cereals like cornflakes, rice
flakes, Choco flakes and pressed rice uses
and storage

06

10%

Pulses —its types and uses

04

10%

Fruits and vegetables- classification and
uses

10

15%

Dairy products- milk —its uses composition
and storage, classification and uses of
cheese, butter, cream

10

15%

MID TERM EXAM

Prevailing food standards in INDIA, food
adulterations as public health hazard, and
common adulterants, simple tests in

06

10%

o
J L National Council for Hotel Management & Catering Technology, Noida.
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detection of common food adulterants, IS,
AGMARK and FSSAI

Herbs spices and condiments- classification

0,
and uses of different types 04 10%
Fruits and vegetables; classification and 05 10%
uses
Tea, coffee, coco and their sources, storage
and uses. Food flavours, essences and 10 10%
food colours with brand names.
Food Preservation — long term and short
term methods. Convenience food, sugar 05 10%
preserves and confectionery gums
Total 60 100%

o
J L National Council for Hotel Management & Catering Technology, Noida.
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FOOD COSTING (DCS-02)

TIME ALLOTTED: 02 HOURS PER WEEK

MAXIMUM MARKS: 50

ACTIVITY MAXIMUM MARKS
Marks for attendance 2
Mid-term exam marks 12 %
Total (Incourse Assessment Marks) 15
End term exam marks 35
Total 50

Leaning Objectives : At the end of the term / course the Students will be able to:

1. Know different pricing methods and explain the different types of Menu.
2. Explain the importance of food costing and costing techniques.
3. Develop standard recipes and adjust the quantities using adjustment factor.
4. Define and explain Material Costing.
5. Explain in controlling food cost, labour cost, overhead cost etc.
6. Define yield and its types.
7. Calculate standard food cost and explain the techniques in portion cost and
dinner cost.
HOURS WEIGHTAGE
UNIT CONTENT ALLOTTED FOR EXAM
1 Pricing
e Menu pricing styles 08 15%
e Types of menu
o Different methods in pricing
2 Costing
e Importance of food costing 07 10%
e Methods of costing
e Costing techniques
3 | Standard recipes
e Use of standardized recipes 07 10%
e Developing standardized recipes
e Adjustment factor
4 Material costing
e Through purchasing
* receving 08 15%
e issuing
e production
e sales and accounting
J.L National Council for Hotel Management & Catering Technology, Noida. 13
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MID TERM EXAM

5 Control of
e food cost

e labour cost 10 15%
e overhead cost
e miscellaneous cost
6 | Yield
e butchers yield
0,
e cooking yield 10 15%
e portion control
7 Costs
e determining standard food cost .
e calculating portion cost 10 20%
e calculating dinner cost
Total 60 100%

o
J L National Council for Hotel Management & Catering Technology, Noida.
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COOKERY PRACTICAL (DFP-11)

TIME ALLOTTED: 16 HOURS PER WEEK MAXIMUM MARKS: 100
ACTIVITY MAXIMUM MARKS

Marks for attendance 5

Mid-term exam marks 25

Total (Incourse Assessment Marks) 30

End term exam marks 70

Total 100

Skill based learning objectives for Cookery Practical:- After the completion of the
practical course, the student will be able to:

1. Prepare and Present Indian dishes like Rice Varieties, Dal Varieties, Indian
bread, Vegetables and Non-Vegetarian.

Prepare and Present Indian Sweets and Snacks.

Prepare and Present Tandoor dishes.

Prepare and Present festival menus.

Prepare and Present Sauces, Soups and Pastas

Prepare and Present Continental dishes of Fish, Poultry and other meat with
accompaniments.

7. Prepare and Present Chinese Soups, Noodles and Rice Varieties etc.

o gk wnN

IMPORTANT:

1. Two students to work on one station in Basic Training Kitchen.

Practical in Quantity Food Kitchen shall be a team activity for bulk cooking.

3. Each menu to be practiced in Basic Training Kitchen by preparing four
portions of each dish at each station.

4. Same menu to be practiced in Quantity Food Kitchen through team exercise
on minimum twenty portions.

no

Familiarisation of tools / equipment and their use. (One week/ 16 Hours)

A set of 60 menus shall be drawn, by the institute covering all the items listed below,
ensuring that all cooking methods have been employed. It may also be ensured that
each menu is prepared once in the basic training kitchen and once in the quantity
food kitchen.

(Hours available: 31 weeks x 4 days/week x 4 hours/day= 496 Hours)

o
J L National Council for Hotel Management & Catering Technology, Noida. 15
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INDIAN

Rice 08 varieties

Indian Bread 10 varieties

Dal 10 varieties

Vegetables 15 varieties

Chutney 05 varieties

Raita 05 varieties

Egg dishes 03 varieties

Fish dishes 05 varieties (including two local cuisine dishes)
Meat dishes 08 varieties (including two local cuisine dishes)
Chicken dishes 08 varieties (including two local cuisine dishes)
Shorba 02 varieties

Tandoor dishes Tandoori chicken, tandoori fish, seek kabab, boti

kabab.

Snacks 10 varieties (including two local cuisine dishes)
Sweets 08 varieties (including two local cuisine dishes)

Special dishes for festivals — 5 festival menus (emphasis on regional cuisine-)

Continental:
Stock — white stock, brown stock, fish stock.

Sauce — Béchamel sauce, Veloute sauce, tomato, espagnole, hollandaise
and mayonnaise with 5 derivatives of each. Demi-glace, Mint sauce,
horse radish, bread sauce and apple sauce.

Compound Butters — 3 varieties.
Soups:

Purees 2 varieties
Cream 3 varieties
Veloute 2 varieties
Broths 2 varieties
Bisques 1 varieties
Consommeés 5 varieties
Cold Soups 2 varieties
International soups 2 varieties
Fish:

Baked 2 varieties
Grilled 2 varieties
Shallow fried 2 varieties
Deep fried 4 varieties
Poached 2 varieties

o
J L National Council for Hotel Management & Catering Technology, Noida.
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Chicken and other Meats:

Stew 2 varieties

Casseroles 2 varieties

Roast 2 varieties

Braised 2 varieties

Grilled/Baked 2 varieties

Chicken (Sautés) 5 varieties

Vegetables:

Preparation and cooking of vegetables — 10 varieties.
Potatoes — 10 varieties.

Farinaceous dishes:

Spaghetti and macaroni dishes — 6 varieties.
Edqqg:

Breakfast egg preparation — 5 varieties
Sweets:

Mousse 3 varieties

Soufflés 3 varieties

Baked 3 varieties

Steamed (Pudding) 3 varieties

Chinese:

Soups 2 varieties

Noodles & Rice 4 varieties

Chicken 2 varieties

Pork 2 varieties

Meat 2 varieties

Prawns 2 varieties

Fish 1 dish

Vegetables 3 varieties

o
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Marking scheme for Examination

Cookery Practical (DFP-11)

Maximum Marks 100 Pass Marks 50

Part ‘A’ (25 Marks)

Uniform & Grooming

Indenting

Scullery, equipment cleaning & Hygiene
Journal

rpwbnE

Total

Part ‘B’ (75 Marks)

1. Each student will prepare five dishes in a meal. Dishes shall be from the

prescribed syllabus.
2. Each dish shall carry 15 marks
3. Parameters of assessment of each dish.

a) Temperature

b) Texture/ consistency
c) Aroma/ flavour

d) Taste

e) Presentation

Total
NOTE:

MARKS
05
05
05
10

25

Marks
03
03
03
03
03

15

1. Journal is not allowed during indenting or practical. It must be handed over to

the examiner before commencement of examination.

2. Assessment will be done by both internal and external Examiner.
3. Each student will prepare 04 portions of each dish/item.
4. Extra ingredients may be made available in case of failure but of limited types

and quality (groceries and dairy products only). Only one extra attempt may

be permitted.

5. Uniform and grooming must be checked by the examiners before

commencement of examination.

6. Students are not allowed to take help from books, notes, journal or any other

person.

7. The Examiners will ensure that examinee adheres to Good Hygiene and Food

safety practices during the examination.

o
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LARDER PRACTICAL (DFP-12)

TIME ALLOTTED: 04 HOURS PER WEEK MAXIMUM MARKS: 100
ACTIVITY MAXIMUM MARKS
Marks for attendance 5
Mid-term exam marks 25
Total (Incourse Assessment Marks) 30
End term exam marks 70
Total 100
Skill Based objectives for Larder Practical:- After the completion of Larder
Practical the Students will be able to:
1. Prepare and Present Simple and Compound Salads.
2. Prepare and Present Hors d’oeuvre and Sandwiches.
3. Prepare and Present Cold Soups.
4. Assemble cold buffet and decorative works like Ice & Butter Sculpture,
Vegetable and Fruit Carving etc.
5. Prepare and Present cold cuts like Galantine, Ballottine, Mousse etc.
1. Preparation of various simple and compound hors d'oeuvres
2. Sandwiches - 5 varieties
3. Simple salads - 5 varieties
4. Cold Soups - 3 varieties
5. Compound Salads:
Fruit based - 2 varieties
Fish based - 2 varieties
Meat based - 2 varieties
Vegetable based - 2 varieties
Preparation of salad dressings — 3 varieties
6. Butchery:
i) Lamb and Mutton — Demonstration of jointing mutton carcasses.
Deboning of mutton leg and shoulder. Curry cuts and boti kababs.
i) Pork — Demonstration and preparation of pork chops, deboning of pork
leg.
iii) Fish — cuts of fish and its use in cold buffets.
iv) Poultry — Dressing, trussing and deboning.
7. Decorative Work:
i) Demonstration of Ice & Butter Sculpture
i) Hand on Training on Vegetable & Fruit Carving
8. Demonstration and Preparation of Galantine, Ballottine, Mousse etc.
J.L National Council for Hotel Management & Catering Technology, Noida. 19
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Marking scheme for Examination

Larder Practical (DFP-12)

Maximum Marks 100 Pass Marks 50
Part ‘A’ 25 Marks

MARKS
1. Uniform & Grooming : 05
2. Indenting : 10
3. Journal : 10
Total : 25
Part ‘B’ 75 marks
1. Five dishes to be prepared as under;
i) 02 Hors d’oeuvres
i) 02 Compound salad
iii) 01 Sandwich
2. Each dish shall carry 12 marks
3. Parameters of assessment of each dish.
Marks
a) Appearance : 04
b) Taste : 04
c) Standard Recipe : 04
Total : 12
4. Adherence to Hygiene & Food Safety (overall) : 15
NOTE:
1. Journal is not allowed during indenting or practical. It must be handed over to
the examiner before commencement of examination.
2. Assessment will be done by both internal and external Examiner.
3. Each student will prepare 02 (Two) portions of each dish/item.
4. Extra ingredients may be made available in case of failure but of limited types
and quantity. Only one extra attempt may be permitted.
5. Uniform and grooming must be checked by the examiners before
commencement of examination.
6. Students are not allowed to take help from books, notes, journal or any other
person.
7. The Examiners will ensure that examinee adheres to Good Hygiene and Food
safety practices during the examination.
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COMPUTER AWARENESS (DCS-11)
TIME ALLOTTED: 01 HOURS PER WEEK

MAXIMUM MARKS: Nil

Learning Objectives:- After the completion of Computer Awareness subject, the
Students will be able to:

1.

a o

Understand computer and its hardware & software.
To produce word document with proper formatting
To work on an excel sheet with basic functions.
Brows on net and communicate through e-mail
Prepare small power point presentations.

UNIT

CONTENT

HOURS ALLOTTED

KNOWING COMPUTER

e What is computer?

» Basic Applications of Computer
e Components of Computer System
Central Processing Unit
Keyboard, mouse and VDU
Other Input devices
Other Output devices
Computer Memory
oncept of Hardware and Software
Hardware
Software

R/

% Application Software
% Systems software
e Concept of computing, data and information
e Applications of IECT
» e-governance
» Entertainment
e Bringing computer to life
» Connecting keyboard, mouse, monitor
and printer to CPU
» Checking power supply

OVVYVYY

VvV VvV

OPERATING COMPUTER USING GUI BASED
OPERATING SYSTEM

e Basics of Operating System
» Operating system
» Basics of popular operating system
(LINUX, WINDOWS)
e The User Interface
» Task Bar

o
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» lcons

» Menu

» Running an Application
e Operating System Simple Setting
Changing System Date And Time
Changing Display Properties
To Add Or Remove A Windows
Component
Changing Mouse Properties
Adding and removing Printers
¢ File and Directory Management

» Creating and renaming of files and

directories

YV VVYY

UNDERSTANDING WORD PROCESSING

e Word Processing Basics
» Opening Word Processing
» Menu Bar
» Using The Help
» Using The Icons Below Menu Bar
e Opening and closing Documents
» Opening Documents
» Save and Save as
» Page Setup
> Print Preview
» Printing of Documents
e Text Creation and manipulation
Document Creation
Editing Text
Text Selection
Cut, Copy and Paste
Spell check
Thesaurus
e Formatting the Text
» Font and Size selection
» Alignment of Text
» Paragraph Indenting
> Bullets and Numbering
» Changing case
e Table Manipulation
» Draw Table
» Changing cell width and height
» Alignment of Text in cell
» Delete / Insertion of row and column
» Border and shading

YVVVYVYYYVY

USING SPREAD SHEET

e Elements of Electronic Spread Sheet
» Opening of Spread Sheet
» Addressing of Cells

o
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» Printing of Spread Sheet

» Saving Workbooks

Manipulation of Cells

» Entering Text, Numbers and Dates

» Creating Text, Number and Date Series
> Editing Worksheet Data

> Inserting and Deleting Rows, Column
» Changing Cell Height and Width
Formulas and Function

» Using Formulas

» Function

5 INTRODUCTION TO INTERNET, WWW AND

WEB BROWSERS

Basic of Computer Networks
» Local Area Network (LAN)
» Wide Area Network (WAN)
Internet

» Concept of Internet

> Applications of Internet

» Connecting to the Internet
» Troubleshooting

World Wide Web (WWW)
Web Browsing Softwares

» Popular Web Browsing Softwares
Search Engines

» Popular Search Engines / Search for
content

Accessing Web Browser
Using Favourites Folder
Downloading Web Pages
Printing Web Pages
Understanding URL

Surfing the web

Using e-governance website

YV VY

6 COMMUNICATIONS AND COLLABORATION

Basics of E-mail

» What is an Electronic Mall

Using E-mails

Opening Email account

Mailbox: Inbox and Outbox
Creating and Sending a new E-mail
Replying to an E-mail message
Forwarding an E-mail message
Sorting and Searching emails
Document collaboration

Instant Messaging and Collaboration

VVVVVYY

o
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>
>
>

Using Instant messaging
Instant messaging providers
Netiquettes

7 MAKING SMALL PRESENTATIONS

Basics

>

» Opening A PowerPoint Presentation

>

Using PowerPoint

Saving A Presentation

Creation of Presentation

>

>
>
>

Creating a Presentation Using a
Template

Creating a Blank Presentation
Entering and Editing Text
Inserting And Deleting Slides in a
Presentation

Preparation of Slides

>

>
>
>

Inserting Word Table or An Excel
Worksheet

Adding Clip Art Pictures

Inserting Other Objects

Resizing and Scaling an Object

Presentation of Slides

>
>
>

Viewing A Presentation
Choosing a Set Up for Presentation
Printing Slides And Hand-outs

Slide Show

>
>
>

Running a Slide Show
Transition and Slide Timings
Automating a Slide Show

Total

30

o
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Eligibility:
English as a subject.
Duration:
Teaching hours per week: 35 Hours
Effective teaching: 34 weeks

Industrial training:

DIPLOMA IN BAKERY AND CONFECTIONERY

Senior Secondary (10+2) or equivalent with

One Year + six months in industry

TEACHING AND EXAMINATION SCHEME

24 weeks after the annual examinations.

No. | Subject Subject Hours per Term
code week Marks*
THEORY
1 DBC-01 | Bakery 3 100
2 DBC-02 | Confectionery 3 100
3 DBC-03 | Commodities 2 50
4 DCS-01 | Hygiene & Sanitation 2 50
5 DCS-02 | Food Costing 2 50
TOTAL 12 350
PRACTICAL
7 DBC-11 | Bakery 12 100
8 DBC-12 | Confectionary 08 100
9 DCS-11 | Computer Awareness 01 -
10 DCS-12 | Library 02 -
TOTAL 23 200
GRAND TOTAL 35 550

* Term marks will comprise 30% Mid Term Exam & 70% End Term Exam Marks.

RULES AT A GLANCE

NO. TOPIC REQUIREMENT
1. Attendance required to become eligible for exam 75% in aggregate

2. Minimum pass marks for each theory subject 40%

3. Minimum pass marks for each practical subject 50%

4. Maximum duration to pass/clear all subjects/ papers | 03 academic years

-
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BAKERY THEORY (DBC - 01)

TIME ALLOTTED: 3 HOURS PER WEEK

MAXIMUM MARKS: 100

ACTIVITY MAXIMUM MARKS
Marks for attendance 5
Mid-term exam marks 25
Total (Incourse Assessment Marks) 30
End term exam marks 70
Total 100

Learning Objectives : At the end of the term / course the Students will be able to:

1.

o gk wnN

Draw the organization chart and kitchen hierarchy of bakery department

Explain the different ingredients used in bakery

Explain the different working temperatures for bakery products
Define the bread faults and remedies of bakery products

Draw and explain the layout of a bakery

Write recipes of different breads, pastries and gateaux

UNIT

CONTENT

HOURS
ALLOTTED

WEIGHTAGE
FOR EXAM

Introduction

Scope of Bakery & Confectionery,
Bakery terms.

Organisation chart of Bakery.

10 15%

Wheat and Flour

o Different types of flours available,
Constituents of flours,
pH Value of flour,
Water absorption power of flour,
Gluten, diastatic capacity of flour,
Grade of flour.
Temperature/ Weight conversions
1 unit; °F/ °C /gms / |b serving size

15 15%

Raw material required for bread making:

- Role of flour, water, yeast, salt
- Sugar, milk and fats

10 10%

Yeast
e An elementary knowledge of Baker’s
yeast, the part it plays in the

L
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fermentation of dough and
conditions influencing it's working.
e Effect of over and under
fermentation and under proofing of
dough and other fermented goods.

05

05%

Bread improvers-improving physical
quality

05

05%

MID TERM EXAM

Oven & Baking:
¢ Knowledge and working of various
types of oven.
e Baking temperatures for bread,
confectionery goods.

05

05%

Methods of bread making :
Straight dough method
Delayed salt method

No time dough method
Sponge and dough method

10

10%

Characteristics of good bread
e External characteristics
e Volume, symmetry of shape
¢ Internal characteristics - colour,
texture, aroma, clarity and elasticity

10

10%

Bread faults and their remedies

05

10%

10

Bakery layout — The required approvals
for setting up of a Bakery — Government
procedure and Bye-laws.

Selection of site

Selection of equipment.

Layout design

Electricity.

10

10%

11

Quality control
e of raw material
e of finished products

05

05%

Total

90

100%

-
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CONFECTIONERY (DBC-02)

TIME ALLOTTED: 3 HOURS PER WEEK

MAXIMUM MARKS: 100

ACTIVITY MAXIMUM MARKS
Marks for attendance 5
Mid-term exam marks 25
Total (Incourse Assessment Marks) 30
End term exam marks 70
Total 100

Learning Objectives : At the end of the term / course the Students will be able to:

CoNoOrWNE

Explain the different ingredients used in confectionery

Differentiate different cake mixing methods

Define and explain different pastries and derivatives

Operation of different types of oven

Define the internal and external characteristics of cakes

Describe the different cake faults and remedies

List down the steps in preparing cookies and biscuits

Explain the procedure in preparing Ice Creams

Demonstrate working knowledge of Chocolate and Sugar confectionery

UNIT

CONTENT

HOURS WEIGHTAGE
ALLOTTED FOR EXAM

Ingredient used in Cake Making
Types & Varieties

Flour

Sugar

Shortening — Fats and oll
Egg

Moistening agent
Leavening Agents

10 15%

Cake Making Methods

Sugar butter process,

Flour butter process,

Genoise method

Blending and rubbing method.

10 10%

Basic Pastries
Pastry making, principles & derivatives

10 10%

Characteristic of Cakes
Balancing cake formula
External characteristics
Internal Characteristics

15 15%

L
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Cake Faults and remedies

MID TERM EXAM

Chocolate

Identify different forms in which coco and
chocolate are available

Explain the process of chocolate
tempering

Chocolate designs, garnishes and
presentations

10

15 %

Sugar

Identify and describe the different stages
of cooking sugar

Caramelized Sugar preparations

Sugar for desserts and presentations

10

15 %

Types of icing

05

05%

Preparation of cookies and biscuits.
Factors affecting the quality of biscuits /
cookies.

08

05%

Various types ice creams and bombs.

07

05%

10

Storage of confectionery product

05

05%

Total

90

100%

L
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COMMODITIES (DBC-03)

TIME ALLOTTED: 02 HOURS PER WEEK

MAXIMUM MARKS: 50

ACTIVITY MAXIMUM MARKS
Marks for attendance 2
Mid-term exam marks 12 %
Total (Incourse Assessment Marks) 15
End term exam marks 35
Total 50

Learning Objectives : At the end of the term / course the Students will be able to:

1. Explain the composition of wheat and wheat products
2. Describe the different types of sugar and its substitutes.
3. List the different types and quality of eggs and dairy products
4. Define yeast and explain its role in bakery and confectionery
5. Explain the types of shortenings and its role in bakery and confectionery.
6. Elaborate the role of gelling agents, stabilizers and preservatives in bakery
and confectionery.
7. Define the food laws and follow H.A.C.C.P Principles
UNIT CONTENT HOURS WEIGHTAGE
ALLOTTED FOR EXAM
1 | Wheat
e composition, production, grade and
quality 10 15 %
e wheat products,
e other flours, meals and starches
2 Sugar
e sugar substitutes
e syrups, jams and marmalades 05 10%
e Cocoa production
e Cocoa by-products
3 Eggs and dairy products
e types
e importance in bakery and 10 15%
confectionery
e grading, quality and selection
4 Leavening agents
_ o 05 10%
e Yeast and its varieties

L
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e Role in raising bakery products
e Chemical leavening agents

MID TERM EXAM

Shortenings
¢ Role of shortening
e Types
e Usage in bakery and confectionery

06

10%

Gelling agents and stabilizers

e Their role in bakery and confectionery
e Food additives and preservatives

e Edible garnishes

e Canned food

12

20%

e Introduction to food laws

e Storage and preservation of bakery
and confectionery products

e Organic and genetically modified
foods

12

20%

Total

60

100%

L
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HYGIENE AND SANITATION (DCS-01)

TIME ALLOTTED: 02 HOURS PER WEEK

MAXIMUM MARKS: 50

ACTIVITY MAXIMUM MARKS
Marks for attendance 2
Mid-term exam marks 12 %
Total (Incourse Assessment Marks) 15
End term exam marks 35
Total 50

LEARNING OBJECTIVES: After completion of the subject a student will be able to:

Follow sanitary procedure during food handling;
Understand the importance of personal hygiene
Analyze critical control points; and

a s PRE

Understand Food Microbiology, Food Contamination and Spoilage;

Practice laws governing the food safety and standards

No CONTENT

TIME WEIGHTAGE
ALLOTTED | FOR EXAM

1 | FOOD MICROBIOLOGY

e Introduction
e Microorganism groups important in food
microbiology
- Viruses
- Bacteria
- Fungi (Yeast & Molds)
- Algae
- Parasites
e Factors affecting the growth of microbes
e Beneficial role of Microorganisms

10 15%

2 | FOOD CONTAMINATION AND SPOILAGE

e Classification Of Food

e Contamination And Cross
Contamination

e Spoilages Of Various Food With The
Storing Method

05 10%

3 | SANITARY PROCEDURE FOLLOWED DURINC
FOOD HANDLING
e Receiving,
e Storage,
e Preparation,

e Cooking,

10 20%

L
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e Holding, and
e Service Of The Food

MID TERM EXAM

SAFE FOOD HANDLER
e Personal Hygiene discussing all the
standard.
e Hand Washing Procedure
e First Aid definition, types of cuts,
wounds, lacerations with reasons and
precautions.

10

15%

HAZARD ANALYSIS CRITICAL CONTROL
POINT

¢ Introduction to HACCP

e History

e Principles of HACCP

10

15%

FOOD SAFETY STANDARDS AUTHORITY
OF INDIA (FSSAI)

e Introduction to FSSAI

e Role of FSSAI

e FSSAI Compliance

05

15%

GARBAGE DISPOSAL
o Different Methods
¢ Advantages & Disadvantages
e Municipal Laws and Swachh Abhiyan

10

10%

Total

60

100%

L

-

National Council for Hotel Management & Catering Technology, Noida.

41



FOOD COSTING (DCS-02)

TIME ALLOTTED: 02 HOURS PER WEEK

MAXIMUM MARKS: 50

ACTIVITY MAXIMUM MARKS
Marks for attendance 2
Mid-term exam marks 12 Y2
Total (Incourse Assessment Marks) 15
End term exam marks 35
Total 50

Leaning Objectives : At the end of the term / course the Students will be able to:

1. Know different pricing methods and explain the different types of Menu.
2. Explain the importance of food costing and costing techniques.
3. Develop standard recipes and adjust the quantities using adjustment factor.
4. Define and explain Material Costing.
5. Explain in controlling food cost, labour cost, overhead cost etc.
6. Define yield and its types.
7. Calculate standard food cost and explain the techniques in portion cost and
dinner cost.
UNIT CONTENT HOURS WEIGHTAGE
ALLOTTED FOR EXAM
1 Pricing
e Menu pricing styles
e Types of menu 08 15 %
e Different methods in pricing
2 | Costing
¢ Importance of food costing
e Methods of costing 07 10%
e Costing techniques
3 Standard recipes
e Use of standardized recipes
 Developing standardized recipes 07 10%
e Adjustment factor
4 Material costing
e Through purchasing
. receiving 08 15%
e issuing
e production
e sales and accounting
J.L National Council for Hotel Management & Catering Technology, Noida. 10
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MID TERM EXAM

Control of

food cost
labour cost
overhead cost

[ ]
[
[
e miscellaneous cost

10

15%

Yield

e butchers yield
e cooking yield
e portion control

10

15%

Costs
e determining standard food cost
e calculating portion cost
e calculating dinner cost

10

20%

Total

60

100%

L
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BAKERY PRACTICAL (DBC - 11)

TIME ALLOTTED: 12 HOURS PER WEEK MAXIMUM MARKS: 100
ACTIVITY MAXIMUM MARKS
Marks for attendance 5
Mid-term exam marks 25
Total (Incourse Assessment Marks) 30
End term exam marks 70
Total 100

Learning Objectives : At the end of the term / course the students will be able to:

Identify and differentiate the small and large equipment in bakery

Identify and check for quality of different types of ingredients used in bakery
Prepare and Present yeast fermented products

Prepare and Present flavoured breads

Prepare and Present Breakfast breads

Prepare and Present laminated breads

Prepare International breads

Prepare toppings and stuffing for pizza and burgers

ONOORAWNE

UNIT CONTENT HOURS ALLOTTED

1 Introduction to ingredients / EQuipment

e Identification and uses of equipment — large, small
and utilities

e Ingredients — Types of flour, Sugar, Nuts and Dry
fruits, Shortenings, leavening etc.

36

2 Quality Checking & Basic Mixing Methods

e Flour: W.A.P Test, Gluten Content 36
e Yeast : Flying fermentation

3 Mixing Methods

e Basic steps involved in mixing ingredients —

Kneading, stirring, whipping, creaming etc. 36

4 Simple yeast fermented products
36
e Bread Sticks, Bread Rolls, hand and Soft

Rolls, sour dough etc.

5 Flavoured Breads

e Basic Buns, Fruit Buns, Hot Cross Buns,

-
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Tomato Rolls and Garlic Rolls 36
6 Rich Yeast Fermented Breads
Brioche, Fermented Doughnuts, Baba au Rhum, 36
Savarin
7 Bread Loafs:
Milk Bread, Bread Loaf, Currant Loaf, Whole Meal 36
Bread, Masala Bread, Raisin Bread
8 International Bread
French Bread, Chelsea Buns 36
9 Laminated Yeast Breads
Danish pastry croissants 36
10 Burger Buns, Pizza Base 36
Total 360

L
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MARKING SCHEME FOR PRACTICAL EXAMINATION
BAKERY PRACTICAL (DBC - 11)

Maximum Marks 100 Pass Marks 50
Part ‘A’ 25 Marks
MARKS
1. Uniform & Grooming : 05
2. Journal : 10
3. Viva : 10
Total : 25

Part ‘B’ 75 Marks

1. Each student to prepare three different breads from the syllabus

2. Each item shall carry 20 marks
3. Parameters of assessment of each item.
a) Appearance & colour : 03
b) Volume & symmetry of shape : 03
c) Texture : 03
d) Aroma : 03
e) Elasticity : 03
f) Correct recipe& equipment : 05
Total : 20
4. Adherence to Hygiene & Food Safety : 15

NOTE:

1. Journal is not allowed during indenting or practical. It must be handed over to
the examiner before commencement of examination.

2. Assessment will be done by both internal and external Examiner.

3. Extra ingredients may be made available in case of failure but of limited types
and quantity. Only one extra attempt may be permitted.

4. Uniform and grooming must be checked by the examiners before

commencement of examination.

Students are not allowed to take help from books, notes, journal or person.

The Examiners will ensure that examinee adheres to Good Hygiene and Food

safety practices during the examination.

o o
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CONFECTIONERY PRACTICAL (DBC - 12)

TIME ALLOTTED: 8 HOURS PER WEEK MAXIMUM MARKS: 100
ACTIVITY MAXIMUM MARKS
Marks for attendance 5
Mid-term exam marks 25
Total (Incourse Assessment Marks) 30
End term exam marks 70
Total 100

Learning Objectives : At the end of the term / course the Students will be able to:

1.

©CoNoOO~WN

Identify and check for quality of different types of ingredients used in
confectionery

Identify and differentiate the small and large equipment used in confectionery
Prepare and Present basic sponges

Prepare and Present different cookies and biscuits

Prepare and Present basic pastries and its derivatives

Prepare basic icings and toppings

Prepare and Present international cakes and puddings

Prepare and Store Ice Creams, Toffees and Indian Sweets

Ability to work with chocolate and sugar to create design, plates and show
pieces

UNIT

CONTENT HOURS ALLOTTED

Basic Cake Making

Plain Sponge

Madeira Cake, Rock Cake, Fruit Cake
Fatless Sponge

Swiss Rolls 22
Genoise Sponge

Biscuits & Cookies:

Plain biscuits; piping biscuits; cherry knobs; langue
—de — chats; (cats tongue) salted biscuits; nut
biscuits; coconut biscuits; melting moment;
macaroons; tricolour; chocolate biscuits; marble
biscuits; nan-khatai; short bread biscuits.

Ginger biscuits; cheese biscuits; cream fingers.

22

Basic Pastry & derivatives:

() Short Crust Pastry
Jam tart, Lemon curd tart

Apple Pie, Banana Flan, Fruit Tartlets. 22

L
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(i) Choux Pastry
Chocolate Eclairs, Profit role
Cream puff
(iii)  Puff Pastry & flaky pastry
Khara Biscuits, veg patties, chicken patties
Mutton patties, Cheese Straws, patty case
Bouchee, vol-au-vents,
Mille Feuillet, Jalousie,
Creams Horns
Apple Strudel
Filo or phyllo pastries such as baklava

4 Icings and Toppings

Fondant; American frosting; butter cream icing;

royal icing; gum paste; marzipan; marshmallow;

lemon meringue; fudge; almond paste; glace icing 22
5 Pastry & Special Cakes

Queen cakes, Easter Egg

Chocolate dippings

Cheese cake, Baba-cum Rhum

Savarin Chantilly, meringues chantilly. Madeline 22

cake

Pineapple pastry, chocolate pastry
6 Icing Cakes

Birthday cake

Wedding cakes 22
7 Gateaux

Black forest Gateaux, gateaux religious 16
8 Puddings and Desserts

Hot dessert : Caramel Custard, soufflé chaud

Bread and Butter pudding, Creme brdlée

Cold Desserts:

Bavarois; ginger pudding; cold lemon soufflé; 22

chocolate mousse; charlotte royale; charlotte

russe; charlotte harlequin; bavarois urbane; soufflé

praline; fruit trifle.
9 Ice Cream

Vanilla, strawberry, chocolate, pineapple, mango,

Sorbets, Bombe, Sundaes, Parfaits 22
10 Toffees:

L

-

National Council for Hotel Management & Catering Technology, Noida.

16

48



Milk Toffee, Chocolates

Stick Jaws, liquor chocolates

Indian Confectionery:

Chenna - Rasgulla, Chamcham, Pakiza, Chenna
Toast, Rasmalai

Khoya - Gulab Jamun, Barfi

Sugar - Mysore Pak, Ghewar

Flour / Besan - Patisa, Shakarpare, Halwa,
Laddoo, Peda.

Milk - Kheer, Rabri

Nuts - Barfi, Chekki

22

11

Chocolate Work

Fundamentals of the science of chocolate.
Established industry standards in -

Tempering, moulding, modelling, enrobing, filling,
show pieces, stencils, chocolate couverture.

Chocolate candies, ganache fillings, hand-dipped
candies, molded bonbons, Danish pastry and
truffles, use of an enrobing machine.

Clean and store chocolate candy moulds and other
equipment used in chocolate candy making

Sugar Work

Chemical properties and changes in sugars at
various stages of the cooking and cooling
processes.

Pulled, blown, Spun, Poured, caramelized sugar.
Casting of sugar. Pastillage and Saltillage fondant,
gum paste and royal icing

Produce sugar confectioneries such as fruit paste,
guimauve (marshmallow), praline, caramels,
nougats, lollipops, marzipans and gummies.
Prepare sugar sticks, nest, bow,ribbon, flower, leaf,
bubble sugar and decorations

Appropriate package and display of candies.

Plate styling techniques, buffet displays, calories in
bakery and confectionery
What is Michelin Star, restaurants and chefs

28

Total

242

-

National Council for Hotel Management & Catering Technology, Noida.

17

49



MARKING SCHEME FOR PRACTICAL EXAMINATION
CONFECTIONERY PRACTICAL (DBC - 12)

Maximum Marks 100 Pass Marks 50
Part ‘A’ 25 Marks
MARKS
1. Uniform & Grooming : 05
2. Journal : 10
3. Viva : 10
Total : 25

Part ‘B’ 75 Marks

1. Each student to prepare three different items as under
i) One small cake with icing
i) One pastry item
iii) One hot/cold dessert

2. Each item shall carry 20 marks

3. Parameters of assessment of each item

a) Appearance & Colour : 03

b) Texture ; 03

c) Aroma & Flavour ; 03

d) Consistency : 03

e) Taste : 03

f) Correct recipe & Equipment : 05
TOTAL ; 20

4. Adherence to Hygiene & Food Safety : 15

NOTE:

1. Journal is not allowed during indenting or practical. It must be handed over to
the examiner before commencement of examination.

2. Assessment will be done by both internal and external Examiner.

3. Extra ingredients may be made available in case of failure but of limited types
and quantity. Only one extra attempt may be permitted.

4. Uniform and grooming must be checked by the examiners before

commencement of examination.

Students are not allowed to take help from books, notes, journal or person.

The Examiners will ensure that examinee adheres to Good Hygiene and Food

safety practices during the examination.

o o

L
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TIME ALLOTTED: 01 HOURS PER WEEK

COMPUTER AWARENESS (DCS-11)

MAXIMUM MARKS: Nil

Learning Objectives:- After the completion of Computer Awareness subject, the
Students will be able to:

agrwnE

Understand computer and its hardware & software.
To produce word document with proper formatting
To work on an excel sheet with basic functions.
Brows on net and communicate through e-mail
Prepare small power point presentations.

UNIT

CONTENT

HOURS ALLOTTED

KNOWING COMPUTER

e What is computer?

» Basic Applications of Computer

e Components of Computer System
Central Processing Unit
Keyboard, mouse and VDU
Other Input devices
Other Output devices
Computer Memory
oncept of Hardware and Software
Hardware
Software
% Application Software
s Systems software
e Concept of computing, data and information
e Applications of IECT

» e-governance

» Entertainment
e Bringing computer to life

» Connecting keyboard, mouse, monitor

and printer to CPU
» Checking power supply

OVVYVYY

Y V

OPERATING COMPUTER USING GUI BASED
OPERATING SYSTEM
e Basics of Operating System
» Operating system
» Basics of popular operating system
(LINUX, WINDOWS)
e The User Interface
» Task Bar
» lcons
» Menu

L

-
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» Running an Application
e Operating System Simple Setting
Changing System Date And Time
Changing Display Properties
To Add Or Remove A Windows
Component
Changing Mouse Properties
Adding and removing Printers
¢ File and Directory Management

» Creating and renaming of files and

directories

YV VY

Y VY

UNDERSTANDING WORD PROCESSING
e Word Processing Basics
» Opening Word Processing
» Menu Bar
» Using The Help
» Using The Icons Below Menu Bar
e Opening and closing Documents
» Opening Documents
» Save and Save as
» Page Setup
> Print Preview
» Printing of Documents
e Text Creation and manipulation
Document Creation
Editing Text
Text Selection
Cut, Copy and Paste
Spell check
Thesaurus
e Formatting the Text
» Font and Size selection
» Alignment of Text
» Paragraph Indenting
> Bullets and Numbering
» Changing case
e Table Manipulation
» Draw Table
» Changing cell width and height
» Alignment of Text in cell

YVVYVYYYVY

» Border and shading

> Delete / Insertion of row and column

1N

USING SPREAD SHEET
e Elements of Electronic Spread Sheet
» Opening of Spread Sheet
» Addressing of Cells
» Printing of Spread Sheet
» Saving Workbooks
e Manipulation of Cells

L

-
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Entering Text, Numbers and Dates
Creating Text, Number and Date Series
Editing Worksheet Data
Inserting and Deleting Rows, Column
Changing Cell Height and Width
e Formulas and Function

» Using Formulas

» Function

VVVVY

INTRODUCTION TO INTERNET, WWW AND
WEB BROWSERS
e Basic of Computer Networks
» Local Area Network (LAN)
» Wide Area Network (WAN)
e Internet
» Concept of Internet
» Applications of Internet
» Connecting to the Internet
» Troubleshooting
e World Wide Web (WWW)
e Web Browsing Softwares
» Popular Web Browsing Softwares
e Search Engines
» Popular Search Engines / Search for
content
Accessing Web Browser
Using Favorites Folder
Downloading Web Pages
Printing Web Pages
e Understanding URL
e Surfing the web
e Using e-governance website

YV VVY

COMMUNICATIONS AND COLLABORATION

e Basics of E-mail

» What is an Electronic Mall

e Using E-mails
Opening Email account
Mailbox: Inbox and Outbox
Creating and Sending a new E-mail
Replying to an E-mail message
Forwarding an E-mail message
Sorting and Searching emails
e Document collaboration
¢ Instant Messaging and Collaboration

» Using Instant messaging

» Instant messaging providers

> Netiquettes

VVVVVYY

\I

MAKING SMALL PRESENTATIONS
e Basics

L

-
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» Using PowerPoint

» Opening A PowerPoint Presentation

» Saving A Presentation

Creation of Presentation

» Creating a Presentation Using a

Template

Creating a Blank Presentation

Entering and Editing Text

Inserting And Deleting Slides in a

Presentation

Preparation of Slides

» Inserting Word Table or An Excel
Worksheet

» Adding Clip Art Pictures

» Inserting Other Objects

» Resizing and Scaling an Object

Presentation of Slides

» Viewing A Presentation

» Choosing a Set Up for Presentation

» Printing Slides And Handouts

Slide Show

» Running a Slide Show

» Transition and Slide Timings

» Automating a Slide Show

YV V

TOTAL

30

-
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DIPLOMA IN FOOD AND BEVERAGE SERVICE

Eligibility: Senior Secondary (10+2) or equivalent with
English as a subject.

Duration: One Year + six months in industry

Teaching hours per week: 35 Hours

Effective teaching: 34 weeks

Industrial training: 24 weeks after the annual examinations.

TEACHING AND EXAMINATION SCHEME

No. | Subject Subject Hours per Term
code week Marks*
THEORY
1 DFB-01 | Food Service 5 100
2 DFB-02 | Beverage Service 5 100
3 DFB-03 | Food & Beverage Control 2 50
4 DCS-01 | Hygiene & Sanitation 2 50
5 DCS-03 | Business Communication 2 50
TOTAL 16 350
PRACTICAL
5 DFB-11 | Food Service 8 100
6 DFB-12 | Beverage Service 8 100
7 DCS-11 | Computer Awareness 1 -
8 DCS-12 | Library 2 -
TOTAL 19 200
GRAND TOTAL 35 550

*Term Marks will comprise 30% Mid Term Marks & 70% End Term Exam Marks.

RULES AT A GLANCE

NO. TOPIC REQUIREMENT
1. Attendance required to become eligible for exam 75% in aggregate
2. Minimum pass marks for each theory subject 40%

3. Minimum pass marks for each practical subject 50%

4. Maximum duration to pass/clear all subjects/ papers 03 academic years

o
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FOOD SERVICE (DFB-01)

TIME ALLOTED: 05 HOURS PER WEEK

MAXIMUM MARKS: 100

ACTIVITY MAXIMUM MARKS
Marks for attendance 5
Mid-term exam marks 25
Total (Incourse Assessment Marks) 30
End term exam marks 70
Total 100

Learning objectives: This course shall take the learner through the basic concepts
of Food Service. At the end of this course the student shall be able to identify the
basic styles of service. Differentiate catering establishments, appreciate table laying

skills and methods used in the restaurant.

The course is planned for candidates to develop knowledge, inputs required at the

entry and supervisory level of a star hotel.

UNIT

CONTENT

HOURS
ALLOTTED

WEIGHTAGE
FOR EXAM

1 Hospitality Industry and the waiter

History of catering

Catering establishments

What professional waiters do
differently

Inter and intra departmental co-
operation

10

05%

2 Classification and use of F&B Equipment

Types, care and uses of Tableware,
Hollowware, Crockery, Glassware,
Linen, Furniture and special Equipment
used in the F&B service department

15

10%

3 The F&B Service department

Staff organisation
Duties and Responsibility of the waiter
The Butler

> Role

» Special skills

» Duties
Significance of a pantry

» Layout

» Equipment

» Functions

» Silver polishing
Outlets in a F&B Department-
Restaurant, Bar, Banquet, Poolside,

15

10%

o
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Coffee shop, Pastry shop,Night club
4 Preparation for service
e Mise-en-place
o Mise-en-sce_ne 15 10%
e Rules of laying a table
e Basics of tray set up
5 Menu and courses
e Types of menu
e Basic courses of a French Classical
Menu
Hors de oeuvre, Potage, Poisson,
Entrée, Relevee, Sorbet, Roti,
Legumes, Entremet, Savoury, Dessert, 20 15%
Café
e Service, examples, cover,
accompaniments and sideboard
requirements for dishes from the above
courses
MID TERM EXAM
6 Forms of service
e Silver
e American
e Russian
e Trolley
e Buffet . 20 15%
e Cafeteria
e Family
e QSR
e English
e Room Service
7 Breakfast Service
e Cover, examples and menu and service
of
» Continental BF
» American BF 15 10%
» English BF
» Indian BF
» Buffet
8 Kitchen Stewarding
e Role
e Hierarchy 10 05%
e Equipment
9 Function Catering 15 10%

o
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e Banquets

» Types
» Seating
» Menu
e Out Door Catering
e Events
10 | Specialised F&B Catering
e Airline catering
e Hospital catering
e Cruise line catering 15 10%
e Railway Catering
e Catering services in Armed forces
e Welfare Catering
TOTAL 150 100%

o
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BEVERAGE SERVICE (DFB-02)

TIME ALLOTED: 05 HOURS PER WEEK MAXIMUM MARKS: 100
ACTIVITY MAXIMUM MARKS
Marks for attendance 5
Mid-term exam marks 25
Total (Incourse Assessment Marks) 30
End term exam marks 70
Total 100

At the end of this course a student shall be able to:
e Define and classify different alcoholic and non-alcoholic beverages.
Differentiate different beverages on the menu.
Match wines with Indian & International food items.
Understand alcohol strength of drinks.
Understand effect of alcohol on human body.
Appreciate bar operations.

HOURS | WEIGHTAGE

UNIT SONISINE ALLOTTED | FOR EXAM

1 Non-alcoholic beverages
¢ Classification: Stimulating, Energizing,

Refreshing 10 05%
e Brands
e Service
2 Wines
e Classification
e Production
e New world vs Old world wines
e Grape varieties
e Brand names 20 15%
e Service of Red, white, sparkling wines
e Aperitif wines: Service and popular
brands
¢ Fortified wines: Service and popular
brands
3 | Spirits
e Whisky, Rum, Gin, Vodka, Brandy,
Tequila 20 15%
> Classification
> Brands
> Service
4 Liqueurs
g e 10 05%
e Classification
J.L National Council for Hotel Management & Catering Technology, Noida. 5
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Colour and flavour
Famous brands at least 10

Cocktails

Classification
Rules of making cocktails
Recipe of 20 classical cocktails

15

10%

MID TERM EXAM

Classification
Service
Storage
Brands

15

10%

Liquor

Alcohol and the human body
Strength of drinks
Pouring measure

15

10%

Bar

Layout

Permitted hours

Opening and closing duties
Age and Alcohol

Bar Frauds

Types

Responsible Service and trends

15

10%

Food and wine harmony

Matching wines with international menu
Matching wines with Indian menus

15

10%

10

Retail beverage outlets

Coffee baristas

Chai Bars

Pubs

Juice bars

Operations in FOH, MOH, BOH

15

10%

TOTAL

150

100%
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FOOD & BEVERAGE CONTROL (DFB-03)

TIME ALLOTED: 02 HOURS PER WEEK

MAXIMUM MARKS: 50

ACTIVITY MAXIMUM MARKS
Marks for attendance 2%
Mid-term exam marks 122
Total (Incourse Assessment Marks) 15
End term exam marks 35
Total 50

Learning objectives: To help students to understand the complexities of controlling
the Cost, Food & Beverage products, labour and revenue in Food & Beverage
operations and maximizing profit without sacrificing the quality or quantity of the food
or beverage which goes to the guest.

HOURS WEIGHTAGE

UNIT CONTENT ALLOTTED | FOR EXAM

1 Cost and Sales Concept

Introduction
Cost Concepts 06 10%
Sales Concepts

Cost to Sales Ratio: Cost Percent

2 Control Process

Introduction

Control

The Control Process
Control Systems
Cost Benefit Ratio

06 10%

3 Control Cycle

Purchasing
Receiving 09 15%
Storing
Issuing

4 Menu Engineering & Analysis

e Introduction
e Menu Engineering 09 15%
e Menu Analysis

MID TERM EXAM

5 Controlling Food Sales

e Introduction 08 15%
e The goals of sales control

o
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Optimizing the number of customers
Maximising the profit

Controlling Revenue

Revenue Control using manual means
Revenue Control using computers

Beverage Control

Beverage Purchasing-Receiving-
Storing — Issuing Control
Beverage Production Control
Inventory turnover

Beverage Sales Control

Guest Checks and Control

14

20%

Labour Control

Labour Cost Considerations
Establishing Performance Standards
SOP

Standard Staffing Requirements
Preparing job descriptions

Training Staff

Monitoring Performance

Taking Corrective action to address
discrepancies between standards and
performance

08

15%

TOTAL

60

100%
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HYGIENE AND SANITATION (DCS-01)

TIME ALLOTTED: 02 HOURS PER WEEK

MAXIMUM MARKS: 50

ACTIVITY MAXIMUM MARKS
Marks for attendance 2%
Mid-term exam marks 122
Total (Incourse Assessment Marks) 15
End term exam marks 35
Total 50

LEARNING OBJECTIVES: After completion of the subject a student will be able to:

Follow sanitary procedure during food handling;
Understand the importance of personal hygiene
Analyse critical control points; and

abrwnpeE

Understand Food Microbiology, Food Contamination and Spoilage;

Practice laws governing the food safety and standards

No CONTENT

TIME WEIGHTAGE
ALLOTTED | FOR EXAM

1 | FOOD MICROBIOLOGY

e Introduction
e Microorganism groups important in food
microbiology
- Viruses
- Bacteria
Fungi (Yeast &Molds)
Algae
Parasites
e Factors affecting the growth of microbes
e Beneficial role of Microorganisms

10 15%

2 FOOD CONTAMINATION AND SPOILAGE

¢ Classification Of Food

e Contamination And Cross
Contamination

e Spoilages Of Various Food With The
Storing Method

05 10%

3 | SANITARY PROCEDURE FOLLOWED DURINC
FOOD HANDLING
e Receiving,
e Storage,
e Preparation,
e Cooking,
e Holding, and

10 20%

o
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e Service Of The Food

MID TERM EXAM

SAFE FOOD HANDLER
e Personal Hygiene discussing all the
standard.
e Hand Washing Procedure
e First Aid definition, types of cuts,
wounds, lacerations with reasons and
precautions.

10

15%

HAZARD ANALYSIS CRITICAL CONTROL
POINT

e Introduction to HACCP

e History

e Principles of HACCP

10

15%

FOOD SAFETY STANDARDS AUTHORITY
OF INDIA (FSSAI)

¢ Introduction to FSSAI

¢ Role of FSSAI

e FSSAI Compliance

05

15%

GARBAGE DISPOSAL
e Different Methods
e Advantages and disadvantages
¢ Municipal Laws and Swachh Abhiyan

10

10%

Total

60

100%
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BUSINESS COMMUNICATION (DCS-03)

TIME ALLOTTED: 02 HOURS PER WEEK MAXIMUM MARKS: 50
ACTIVITY MAXIMUM MARKS
Marks for attendance 2%
Mid-term exam marks 12 %
Total (Incourse Assessment Marks) 15
End term exam marks 35
Total 50

LEARNING OBJECTIVES:

Knowledge

Understand the fundamental principles of effective business communication
Identify different forms of communication

Evaluate the difference between the types of communication

Understand the concept of body language and its correct use

PwpnPR

Competencies

5. Apply effective communication in today’s business world

6. Use correct form of communication depending on business situation and
circumstances

7. Organise ideas and express in writing and speaking

8. Participate effectively in groups with emphasis on listening, critical and
reflective thinking and responding

9. Avoid common body language mistakes

Mindset

10. Understand the importance of specifying audience and purpose, and to
select appropriate communication choices

TIME WEIGHTAGE

No CONTENT ALLOTTED | FOR EXAM

1 Introduction to Business Communication

e Definition
e Objectives 10 20%
e Principles of effective communication
e Importance of good communication
2 | Types of communication
e Formal 05 10%
e Informal
e Verbal

o
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e Written
e Horizontal
e Vertical

Essentials of good business letter and

. 05 15%
types of letters — Official, D.O °
Letter writing
e Circular
e Memo
e Notice
e U.O. Note
e Applications 10 20%
e Bio-data (C.V.)
e Covering letter
e Invitations
e Greetings
e Apologies
MID TERM EXAM
Communication with guest and Body
language
e Effective Speaking — Polite and
effective enquiries & responses, 10 15%
Addressing a group
e Listening and note taking skills
e Body language- Importance &
application
Speech Improvement
e Pronunciation, stress, accent
e Importance of speech in hotels
e Common phonetic difficulties 10 10%
e Connective drills exercises
¢ Introduction to frequently used foreign
sounds
Electronic modes of communication:
e Use of telephone
e Taking telephonic orders .
e Telephone etiquette’s 10 10%
o Fax
e E-mail and protocol
e Responsible social media
TOTAL 60 100%

o
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FOOD SERVICE PRACTICAL (DFB-11)

TIME ALLOTED: 08 HOURS PER WEEK MAXIMUM MARKS: 100
ACTIVITY MAXIMUM MARKS

Marks for attendance 5

Mid-term exam marks 25

Total (Incourse Assessment Marks) 30

End term exam marks 70

Total 100

Learning Objective: - This course is envisaged to develop skills related to
professional food service in aspiring candidates. At the end of this course a student
shall be able to.

1. Explain different types of F&B equipment
2. Handle and maintain equipment according to accepted standards
3. Deliver quality food service in the training restaurant.

UNIT CONTENT HOURS
ALLOTTED

1 Familiarization with F&B Equipment 20

2 e Importance of sanitation and hygiene

e Care, cleaning and polishing of F&B equipment

e Mise-en-place and mise-en-scene for different o5
meal periods

e Pantry preparations and service

3 e Laying and relaying of table cloth
Napkin folding 25

Handling of service spoon and service fork
Water service

Service using trays and salvers

Silver service

Clearance

25

5 e Laying and service of special Table d’héte menu
e Laying and service of breakfast set up on trays 25

MID TERM EXAM

6 e Service Sequence- Greeting, seating, order
taking, serving and bill presenting 40
e Briefing and de briefing

7 e Organizing buffets

e Banquet seating plan practice 30

o
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8 e Service of Indian food
e QSR service 20
9 | Silver polishing 15
10 | Bussing and segregating waste at the dish wash 15
Total 240

Marking scheme for Examination
Food Service Practical (DFB-11)

Maximum Marks 100 Pass Marks 50

Part ‘A’ 25 Marks

MARKS
1. Uniform & Grooming : 05
2. Journal : 10
3. Viva : 10
Total : 25

Part ‘B’ (75 Marks)
Marks

a) Mise-en-place : 20
b) Service Efficiency : 20
c) Silver service skills : 20
d) Menu knowledge : 15
Total : 75

NOTE:

1. The examination should test skills and knowledge of the students by
assigning sets of tasks as listed in the practical syllabus under each category.

2. During table service each guest should pose one question to the candidate on
the item being served. The invigilators can brief guests prior to service.

o
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BEVERAGE SERVICE PRACTICAL (DFB-12)

TIME ALLOTED: 08 HOURS PER WEEK

MAXIMUM MARKS: 100

ACTIVITY MAXIMUM MARKS
Marks for attendance 5
Mid-term exam marks 25
Total (Incourse Assessment Marks) 30
End term exam marks 70
Total 100

Learning Objectives: At the end of this course a candidate shall be able to;

1. Use different types of glassware to serve different alcoholic and Non -
alcoholic beverages.
2. Prepare cocktails according to accepted standards.
3. Render different type of beverage service as per SOP.
4. Practice responsible service of liquor.
5. Do formal banquet arrangements
UNIT CONTENT HOURS
ALLOTTED
1 e Service of Tea and coffee
e Service of Non-alcoholic beverages
e Serving from the coffee machine 25
e Service of coffee variations
2 e Wine service — Service of Table wines,
Sparkling wine, Aromatized wines and Fortified
wines. 30
e Food and wine harmony
e Wine appreciation
3 e Service of hard liquors
e Service of liqueurs 25
4 Preparation and service of classical cocktails 20
5 | Service of different types of beer 20
MID TERM EXAM
6 Raising of toast and setting up formal banquet 30
arrangements
7 Setting up a bar 30
8 Preparation of garnishes and mixes for the bar 20
9 | Storage of wines, beer and spirits 20
10 | Responsible Service of Liquor
e Preventing trouble 20
e Complaints and Refusal of Service
e Potential Problem Situations

o
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e Reacting to Trouble
e Recording Incidents

Total 240

MARKING SCHEME FOR EXAMINATION
BEVERAGE SERVICE PRACTICAL (DFB-12)

Maximum Marks 100 Pass Marks 50

Part ‘A’ 20 Marks

MARKS
1. Uniform & Grooming : 05
2. Journal : 10
3. Viva : 10
Total : 25
Part ‘B’ 75 Marks
Marks
a) Mise-en-place : 20
b) Service of tea/coffee : 20
c) Service of wine/beer : 15
d) Service of hard liquor/cocktails : 20
Total : 75

Note:-

1. The examination should test skills and knowledge of the students by
assigning sets of tasks as listed in the practical syllabus under each category.

2. The student must ensure that sideboard contains everything necessary for
service.

3. During table service each guest should pose one question to the candidate on
the item being served. The invigilators can brief guests prior to service.

o
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TIME ALLOTTED: 01 HOURS PER WEEK

COMPUTER AWARENESS (DCS-11)

MAXIMUM MARKS: Nil

Learning Objectives:- After the completion of Computer Awareness subject, the

Students will be able to:

agrwnE

Understand computer and its hardware & software.
To produce word document with proper for matting
To work on an excel sheet with basic functions.
Brows on net and communicate through e-mail
Prepare small power point presentations.

UNIT

CONTENT

HOURS
ALLOTTED

KNOWING COMPUTER
e What is computer?
» Basic Applications of Computer
e Components of Computer System
» Central Processing Unit
» Keyboard, mouse and VDU
» Other Input devices
» Other Output devices
» Computer Memory
e Concept of Hardware and Software
» Hardware
» Software
% Application Software
% Systems software
e Concept of computing, data and information
e Applications of IECT
» e-governance
» Entertainment
e Bringing computer to life
» Connecting keyboard, mouse, monitor and
printer to CPU
» Checking power supply

OPERATING COMPUTER USING GUI BASED
OPERATING SYSTEM
e Basics of Operating System
» Operating system
» Basics of popular operating system (LINUX,
WINDOWS)
e The User Interface
» Task Bar
» lcons
» Menu
» Running an Application
e Operating System Simple Setting
» Changing System Date And Time

o
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Changing Display Properties
To Add Or Remove A Windows Component
Changing Mouse Properties
Adding and removing Printers
e File and Directory Management

» Creating and renaming of files and
directories

YVVY

UNDERSTANDING WORD PROCESSING
e Word Processing Basics
» Opening Word Processing
» Menu Bar
» Using The Help
» Using The Icons Below Menu Bar
e Opening and closing Documents
Opening Documents
Save and Save as
Page Setup
Print Preview
Printing of Documents
ext Creation and manipulation
Document Creation
Editing Text
Text Selection
Cut, Copy and Paste
Spell check
Thesaurus
ormatting the Text
Font and Size selection
Alignment of Text
Paragraph Indenting
Bullets and Numbering
Changing case
able Manipulation
Draw Table
Changing cell width and height
Alignment of Text in cell
Delete / Insertion of row and column
Border and shading

VVYVVVVTIVVVVVVdVVVVY

[ ]
—

VVVYY

USING SPREAD SHEET
e Elements of Electronic Spread Sheet
» Opening of Spread Sheet
» Addressing of Cells
» Printing of Spread Sheet
» Saving Workbooks
e Manipulation of Cells
Entering Text, Numbers and Dates
Creating Text, Number and Date Series
Editing Worksheet Data
Inserting and Deleting Rows, Column
Changing Cell Height and Width
e Formulas and Function

VVVYY

o
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» Using Formulas
» Function

INTRODUCTION TO INTERNET, WWW AND WEB
BROWSERS

Basic of Computer Networks

» Local Area Network (LAN)

» Wide Area Network (WAN)
Internet

» Concept of Internet

» Applications of Internet

» Connecting to the Internet

» Troubleshooting

World Wide Web (WWW)

Web Browsing Software

» Popular Web Browsing software
Search Engines

Popular Search Engines / Search for content
Accessing Web Browser

Using Favourites Folder
Downloading Web Pages
Printing Web Pages
Understanding URL

Surfing the web

Using e-governance website

VVVYY

COMMUNICATIONS AND COLLABORATION

Basics of E-mail

» What is an Electronic Mall

Using E-mails

Opening Email account

Mailbox: Inbox and Outbox
Creating and Sending a new E-mail
Replying to an E-mail message
Forwarding an E-mail message
Sorting and Searching emails
Document collaboration

Instant Messaging and Collaboration
» Using Instant messaging

» Instant messaging providers

» Netiquettes

VVVYYY

MAKING SMALL PRESENTATIONS

Basics

» Using PowerPoint

» Opening A PowerPoint Presentation

» Saving A Presentation

Creation of Presentation

Creating a Presentation Using a Template
Creating a Blank Presentation

Entering and Editing Text

Inserting And Deleting Slides in a
Presentation
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Preparation of Slides

» Inserting Word Table or An Excel Worksheet
» Adding Clip Art Pictures

» Inserting Other Objects

» Resizing and Scaling an Object
Presentation of Slides

» Viewing A Presentation

» Choosing a Set Up for Presentation
» Printing Slides And Hand-outs
Slide Show

» Running a Slide Show

» Transition and Slide Timings

» Automating a Slide Show
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LUCKNOW,
12. UNIFORM

The students will be required to present themselves with proper uniform in the practical & theory
classes.

> Diploma in Food Production and
» Diploma in Bakery & Confectionery

Practical Uniform
MALE/FEMALE : Black trouser, white chef coat, scarf, chef cap, black socks, black shoes.

Theory Uniform:
MALE/FEMALE : Black trouser, white full sleeves shirt, institute prescribed tie, black socks & black shoes.

> Diplomain Food & Beverage Service

Practical Uniform
MALE/FEMALE : Black trouser, white shirt, Black vest coat, institute prescribed tie, black socks& black
shoes.

Theory Uniform:
MALE/FEMALE : Black trouser, white full sleeves shirt, institute prescribed tie, black socks & black shoe.

Attendance:

Students must attend classes, all examination. The students must not refrain themselves from any
institute activity without sanctioned leave. Regular and punctual attendance is required in all classes for

which the student is enrolled.

Each student is required to put in a minimum of 75% attendance failing which he/she shall not be
appear for final examination. 10 % relaxation may be given by the principal in case of medical sickness.

Cellphone
The students are strictly prohibited to use of Cell phones in class rooms, corridor etc. unless in the

case of emergency.
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DIPLOMA COURSES

Hygiene & Sanitation

S. Diploma in FP Diploma in B&C Diploma in FB
No Subject Name Subject Code Subject Name Subject Code Subject Name Subject Code

1 | Cookery (T) DFP-01 Bakery (T) DBC-01 Food Service (T) DFB-01

2 | Cookery (P) DFP-11 Bakery (P) DBC-11 Food Service (P) DFB-11

3 | Larder (T) DFP-02 Confectionery (T) DBC-02 Beverage Service (T) DFB-02

4 | Larder (P) DFP-12 Confectioner (P) DBC-12 Beverage Service (P) DFB-12

5 | Nutrition DFP-03 Commoaodities DBC-03 F&B Control DFB-03

6 | Commodities DFP-04 Hygiene & Sanitation DCS-01 Hygiene & Sanitation DCS-01

7 DCS-01 Food Cost DCS-02 Business Communication DCS-03
8
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